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▪ Was a WordPerfect maven until version 3.1… MS 
Word power user since then. Still says “hard 
return.”
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▪ Longtime volunteer with IDL and Technical Editing 
SIGs and Alberta and Canada West Coast chapters
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Mellissa Ruryk�
Viqui already told you who I am but we include this slide here for people who watch the presentation afterwards. 

You will receive a link to the presentation and a resources list plus a special bonus—a cheat sheet of keyboard shortcuts—after the presentation

I’m not able to answer questions during the presentation – I’m afraid there is too much content to cover. 

 Viqui and I will gather up any questions you ask in the chat box, and I’ll answer afterwards. 

The last slide has my contact information (email and phone number) and you’re also welcome to contact me anytime with questions. Can’t guarantee I can answer ‘em all… 



Who are you?

▪ You use Word and you’re good at it!

▪ Word is what’s available in your office, 
so you use it, grudgingly

▪ You use Word almost exclusively but it 
drives you crazy

▪ Word scares you – you’re never sure 
what it’s going to do next

▪ You use Word a lot but you suspect 
“there must be an easier way!”
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Mellissa Ruryk�
You think you’re already a Word power user. Well, you don’t know what you don’t know… so that’s why you are here. 
I hope to enable you to feel like the characters on this slide – you might have questions but I’m going to see you fly off with the answers to accomplish miracles.


 



Outline of Topics Covered

Setting Up for Success
• Customizing your Word territory
• Nav pane, shortcuts, Options 

Editing Others’ Mistakes
• Find and Replace tips
• Text table, Table  text

How Do We Fix This?
• Captions
• Cross-referencing
• “Same as Previous” headers and 

footers

What’s not in this session

▪ Creating a template

▪ Bullet-proof numbering

These follow-on sessions are 
planned for later in 2021 and 
early 2022
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Mellissa Ruryk�
These are some of the items I plan to cover today.
I wouldn’t say that this presentation is directed at expert users, but neither is it for novices. I assume a certain understanding of Word.
I do believe that every person in attendance or watching the recording will walk away with at least one thing they didn’t know that Word could do.
I do plan to offer a couple of sessions for long-time users later this year.
Note: I use Windows® on a PC, with Word 365. Mac® users may need to do a bit more research, but you’ll still learn to get some Lovin’ out of Word.
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Setting Up For Success

Word is set up for the average user: but we technical writers are 
anything BUT average…

Mellissa Ruryk�
Out of the box (ok, downloaded from the web), Word is set up the way Microsoft thinks you want to use it. As we know, Microsoft is frequently wrong—besides which, you’re a technical writer. You need more functionality than Common Customer Chris. 
I’ll show you the adjustments I think are imperative.



Field Shading and Bookmarks

▪ Access Word Options

File>Options>Advanced>Display

▪ Select Show Bookmarks

▪ Set Field Shading to Always
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Mellissa Ruryk�
If you intensely dislike working with Word’s codes showing (those are also called non-printing characters or formatting characters), you can accidentally type over or delete information that is actually a field or a bookmark.  
Personally, I find it very difficult to work without seeing the codes – they tell me what Word thinks it’s doing. See if you can overcome your distaste for them—at least when you are writing. I know they get in the way of editing sometimes.
There’s a way you can “see” when content is a field or a bookmark while hiding the rest of those “ugly” codes. Make fields appear with a shaded background, and bookmarks with light grey square brackets.
File>Options>Advanced>Display
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Field Shading and Bookmarks
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▪ Square brackets show you 
where a bookmark is

▪ All fields (such as page 
number here) show with a 
grey background

▪ To update all fields in your 
document at once, press 
Ctrl-A (select All), then 
press F9 (update fields)

Field Shading and Bookmarks

Mellissa Ruryk�
Now you can see the square brackets around the word Bookmarks. Now you know not to mess with that word or you might also mess up a cross reference to it. 

Likewise, you can see the grey shading behind the page number that’s circled on the screenshot. 

Using a cross reference to the page number means I don’t need to keep track of where the bookmarks topic moves to… when I click Ctrl-A (to select all content in my document) and press F9, all fields are automatically updated.




Hidden Text and Object Anchors

▪ Access Word Options

File>Options>Advanced>Display

▪ Locate Always show these 
formatting marks on the 
screen

▪ Select Hidden Text and 
Object Anchors
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Mellissa Ruryk�
There are a couple of Display settings that are helpful – these are set in File>Options>Display. 
You can see on this screen shot that you can make Word always show certain formatting marks, regardless of whether you have all codes showing or not. I recommend you always display 2:  hidden text and object anchors.
Some of you know you can use hidden text to make notes in a document and then “hide” them, so they don’t print or show unless someone purposely displays them.
Object anchors show you which paragraph on the text layer a non-inline object is tied to—if that paragraph moves to the next page or elsewhere in your document, the anchor and its object goes, too.
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▪ Hidden text appears underlined with faint green dots

▪ Contrast to the heavier blue dotted underline for grammar 
issues or the heavier red squiggle under a spelling mistake

▪ Best practice to create a style for hidden text with a distinctive 
text color (and hidden text attribute)—makes it easier to see
– Applying the style turns on the hidden text and changes font color at the 

same time

Hidden Text

Mellissa Ruryk�
Hidden text appears on screen with a faint dotted underline.  
Hidden text is a pretty cool way to write yourself notes about why you did things a certain way in a given document, or to give instructions to another user or editor of this document.
It’s a good idea to set up a style for hidden text that has a distinctive text colour, since it can be hard to see that underline. Applying the style can turn on the hidden text attribute and change the font colour at the same time.





Object Anchors

▪ Anchors only appear when 
text wrap for image is set to 
anything but In Line with Text

▪ Anchors are attached to a 
paragraph on the Text Layer. 
Moving or deleting that 
paragraph affects the image

▪ Find the Anchor Lock:
– Select image and right-click
– Select More Layout Options

> Position tab 
> look in lower left corner 
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Mellissa Ruryk�
Anchors don’t appear when text wrapping is set to Inline with Text

When you use any other text wrapping option the image moves to the image layer.

When you turn on Lock Anchor, you can move your image to any position on the same page as the anchor paragraph, and the object stays in that position. However, if you move the anchor paragraph to another page, the object also moves to that page, but it stays in the same relative position on the page. 
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All About Tabs



Tab stops
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▪ Using Tab to reposition text betrays you & never aligns correctly

▪ It’s easy to set and use tabs using the ruler

Mellissa Ruryk�
If someone knows how to use Word properly sees this type of formatting, they know immediately that the person who typed this does NOT know Word.
I’ll show you how to set tabs quickly using the Ruler.



Use the Ruler to Set Tabs Quickly
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Left-aligned

Center-aligned

Right-aligned

Decimal-aligned

Bar tab

Mellissa Ruryk�
(ANIMATION) First, go to the View menu, in the Show section, and click beside the Ruler to turn it on.

You’re working with the Margin if your cursor is double-ended.

The solid up and down arrows are “margin releases” and you can use them to indent or outdent text.

You can cycle through the different types of tabs.

Right, left, centre – click in the ruler to set a tab location. You can drag this around on the ruler or drag it right off the ruler to delete it.

Note that tabs are set for the paragraph you are in. If you move your cursor, the tab you thought you were working with may not be there.




Default Tab stops
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▪ Default tab stops don’t 
show on the ruler

Mellissa Ruryk�
There are default tab stops every half-inch in the default Word paragraph. So when you hit the tab key, it only moves a half-inch. To make text move to the right margin, you have to hit tab 11 times! And you can’t guarantee the words will align—for sure—at the right margin.




Alignment Tabs

▪ Alignment tabs don’t show on 
the ruler

▪ They stay in alignment 
regardless of page size or 
orientation

Doubleclick in the header or footer area to 
open the Header/Footer dialog

▪ Select left, center, or right 
alignment in relation to margin 
or indent
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Mellissa Ruryk�
There’s another type of tab in Word that is not shown on the ruler either.
It’s called the alignment tab and can only be set in a header or footer. 
You used to have to edit each header when the size or orientation of a page changed.
The new feature allows you to insert tabs (left, centre, or right) relative to the margin or an indent setting.
Now when your page size or orientation changes, content in the header appears a half-inch in from the left without any intervention needed from you. Gotta love that!
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Learn to Love the Navigation Pane



Learn to         the Navigation Pane

Outline View and Go To dialog still work, but there’s a skookum upgrade
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Mellissa Ruryk�
There is a lot of wasted white space and you have to study up to learn the meaning of the icons and gaps in the text. I’m not saying the Outline View isn’t useful but I never got the hang of it – others may sing its praises.




▪ Access the Nav pane 
from the View menu

▪ Or, customize your 
quick access toolbar 
to let you turn it on 
or off quickly

▪ Note the 3 tabs –
Headings, Pages, 
Results
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Learn to         the Navigation Pane

Mellissa Ruryk�
ANIMATION
In contrast, the Nav pane is compact, docked on the left side of your monitor (but can be moved) and leaves the rest of your screen real estate free to show you the actual content. The arrow icons are familiar and understandable (expanded headings are black, downward-pointing, collapsed headings are hollow and right-pointing).
A pretty handy tool you might have not seen if you’re a long time Word user who doesn’t have time to explore is the Navigation pane. Microsoft changed the document map in Word 2010, expanded and improved it. The 3 aspects to the navigation pane I’ll cover here are (CLICK) Headings (CLICK) Pages (CLICK) Results





▪ See doc structure and 
doc content at the 
same time, with 
formatting

▪ Move content around 
without fuss

▪ Promote or demote 
sections (and more) 
with a single right-
click
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Learn to         the Navigation Pane

Mellissa Ruryk�
One functionality of the Heading tab on the Nav pane is the ability to grab a whole section (even non-contiguous ones) and move them around in the nav pane. 
Moving them in the Nav pane moves them in your document – with single mouse clicks!  Moving sections is a huge productivity boost if you are doing substantive editing and need to improve document flow. 
Right-click to see how to easily promote or demote sections. Also options for selecting an entire section, printing one section, and collapsing or expanding all sections at once. Pretty skookum!




Nav Pane—Pages Tab

▪ I use this view to 
check for layout 
issues

▪ Resolution of the 
images is fixed but 
you can resize the 
Nav pane to see 1, 2, 
or 3 pages at a time

▪ Click a page to 
move your cursor 
there
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Mellissa Ruryk�
The Pages tab shows you thumbnails of your document, very similar to what you see in a PDF or PowerPoint. I use this to assess whether white space has been used well throughout a document or if the reader is facing a wall of text to wade through.

Page sizes are fixed as shown but you can resize the pane itself to show only a single column of pages, or multiple pages, depending on the width of the Nav pane.




Nav Pane—Results Tab
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▪ Shows a count 
of results

▪ Easily move 
from one result 
to the next 
using the 
arrows

▪ Right click 
down arrow by 
search field to 
see additional 
options

Mellissa Ruryk�
ANIMATION

This tab expands on the usefulness of the Find and Find/Replace dialog. 

You can see the results of your searches in the Nav Pane, plus a count of results and use the arrows to move back and ahead to each occurrence. 

I use this to find inconsistencies in my docs – for instance, spelling rockhounds as a single word, two words, or a hyphenated word. 




Nav Pane—Results Tab
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▪ Find and quickly 
move from one 
object (graphics, 
tables, footnotes, 
etc.) to the next

Mellissa Ruryk�
Even better is its ability to find and let you quickly move from one object to the next, by using the dropdown shown in this screenshot. It’s pretty much the same functionality as the Go To tab in the other Find and Replace dialog box. 

I can never remember where to click to bring up the Go To tab (actually, that would be on the page or section number in the Status bar at the bottom of your monitor). The Nav pane is already open, so… I use that.
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Customize your Status Bar & QAT



Customize the Status Bar

▪ Use the Status bar to 
increase your productivity 
by eliminating keystrokes

▪ My most-used are 
highlighted

Right click on the status bar at the 
bottom of your window
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Mellissa Ruryk�
Right-click on the status bar at the bottom of your window to display options available to you.
There are a number of productivity boosters that reside there. It’s only in the last 6 months I found out I can have the Track Changes toggle displayed there, instead of having to hunt for the Review menu, clicking on it, clicking on Track Changes, and clicking in the document to make it go away. Now I click to toggle between off and on, and save oodles of time.




▪ Note 2 different page counts—handy for printing
– You’ll get a Resources page after the presentation; see hyperlinked article 

(but remember how easy printing from Nav Pane is...)

▪ Word Count given for entire doc or selection

▪ Editor issues in grammar or spelling are indicated by X on book icon
– Open the Editor by double clicking that icon

▪ Favorite new addition is Track Changes toggle on/off
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Status Bar Customizations

Mellissa Ruryk�
Here’s my status bar. The red circle is the edit warning—Word is telling me I have errors in my document and I can quickly bring up the Editor to investigate these by clicking that icon. Note the two different page counts showing. This is handy when you are trying to print specific pages from a multi-sectioned document. 



Customize the Quick Access Toolbar (QAT)

▪ To match the Track Changes 
toggle in the status bar, I 
added Display for Review 
(same options):
– Simple Markup
– All Markup
– No Markup
– Original

▪ Quick Access Toolbar can be 
pinned above or below the 
ribbon
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File > Options > Quick Access Toolbar

Mellissa Ruryk�
ANIMATION  (brings up my QAT)

To match the ability to turn Track changes off and on, I’ve customized the QAT to give me quick access to the Display for Review drop down list.
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Autocorrect



Autocorrect

▪ Click the Autocorrect Options 
button to open the dialog

▪ Enter exceptions to 
Autocorrect

▪ Use options to set exceptions 
for items such as ToC, TCBoK, 
etc.

▪ If you haven’t looked at Word’s 
Grammar refinements lately, 
they’ve been greatly improved.
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Mellissa Ruryk�
ANIMATION to show off adding TOC to Autocorrect and grammar options

Autocorrect – Dialog found in File>Options
Can add exceptions
Add items to be autocorrected as you type
Word’s Grammar checker has evolved greatly the 365 version



Adding to Autocorrect With Spellcheck

▪ I went more than a year 
thinking Word had removed 
the ability to add a 
correction while 
spellchecking…

▪ Note the ability to open 
the Autocorrect dialog 
(last slide) from here
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Mellissa Ruryk�
Autocorrect –. It used to be, when you were spellchecking your document, you were given the option to add a correctly spelled word to Autocorrect and never see it again.
But Word changed things a couple of years ago and it’s hard to see where to add words to Autocorrect now. As a matter of fact, I went for more than a year thinking they’d taken away the Autocorrect option!
When you spellcheck, you can right click on any misspelled word to see Word’s suggestions. If one of them is correct, click on the right pointing arrow on the same line as the correction. A menu expands that gives you the option to add to autocorrect. If you need to, you can even open the Autocorrect Options menu from here (saving 4 mouseclicks to open that dialog and 2 to close it).
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Editing Others’ Mistakes

This section offers strategies for editing other people’s Word 
documents… they can be, uh… “messy”

Mellissa Ruryk�
Possibly you have a new job and you have to bring legacy documentation up to date. Maybe you edit other people’s résumés for a living (if that’s the case, you have my sympathies). 
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Find and Replace



Find and Replace special characters
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Home>Editing>Replace

▪ Turn off Track Changes 
for wholesale changes 
like this

▪ Replace 2 spaces with 1

▪ Repeat until 0 replaced

Mellissa Ruryk�
First thing I do with another person’s file is to replace 2 spaces between sentences with 1 space. Important: make sure track changes is NOT on for big, wholesale changes such as this and the next one.




Find and Replace other than words
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Home>Editing>Replace

▪ Replace 2 paragraph 
marks with 1

▪ Repeat until 0 replaced
– ^p = paragraph
– ^t = tab
– ^l = manual line breaks
– ^m = manual page breaks
– ^b = section break

▪ Use only lower-case 
letters

Mellissa Ruryk�
Next, I replace 2 pilcrows with 1. 
When you replace 2 of anything with 1, sometimes you are left with an odd number of occurrences. So, run these Replace tasks until Word reports that none were replaced.
In this screenshot you see I am using the caret (shift-6) to represent the pilcrow or paragraph mark. Before I knew I could type that in, I would select the Special button at the bottom of the window and this list appears 
The ones I use most often are ^p for paragraph, ^t for tab, ^b for section break, ^l for manual line breaks and ^m for manual page breaks.. Note that the letters you type in must be in lower case.




Special Characters

Home> Editing> Replace> 
More >>> > Special

If you can’t remember the 
codes, click Special to see a 
list of what you can replace 
(without using wildcards)

▪ Using Wildcards presents 
different list

▪ Check out Format choices
– You can swap one Style for 

another
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Mellissa Ruryk�
Note: other characters appear if you have Use Wildcards selected. Not talking about that today.
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Apply Styles



Reformatting Document with Styles
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▪ Size of document and number of images

▪ Smaller doc, few/no images
– Strip all formatting

▪ Ctrl-End
▪ Ctrl-A
▪ Un-select last pilcrow 

– Keep shift key held, let go Ctrl, cick left arrow
▪ Ctrl-C
▪ Open Notepad or Notepad++
▪ Ctrl-V, click anywhere to clear selection
▪ Ctrl-A, Ctrl-C to copy entire contents
▪ Ctrl-V in new doc

Why omit last pilcrow?

Don’t copy corruption 
into new document.

Mellissa Ruryk�
Depending on the size of the document, I might print the original to see what it looked like when it was given to me.  Now that I have 2 monitors, I don’t do this very often anymore. I put the original up on my portrait monitor so I can see each page in its entirety. I can see which content was intended to be in the headers and footers, see headings, bullet points, numbered lists, and anything else that had manual formatting applied. I open a new document on my laptop screen, which has more horizontal real estate.  Now I have room for a few sidebars open for Styles, the Navigation pane, and—when I’m ready—a grammar checker. In addition to Word’s built-in grammar checker, I use Grammarly.




Reformatting Document with Styles
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▪ Size of document and number of images

▪ Larger doc, more/lots of images
– If all formatted as Normal

▪ Copy to new doc omitting last pilcrow
▪ Ctrl-A
▪ Strip all section breaks
▪ Apply Body text Style
▪ Re-apply Heading Styles where appropriate
▪ Apply Image format to images
▪ Apply table style to tables
▪ Add captions to images and tables
▪ Always configure section breaks before adding 

headers and footers, moving from the front of the 
document to the back

▪ Generate ToC

▪ If there is a mix of different 
styles and manual formatting, 
use whatever you need to 
standardize and make styles 
consistent

▪ Reformat manually numbered (or 
bulleted) content with a neat 
trick: selecting text vertically.

Mellissa Ruryk�
Next, I strip all the formatting from the original. If the document is straight text only, this is super easy and fast. I select all the content in the original file (Ctrl-A) and navigate to the end of the document. Holding down the Ctrl key, I de-select the last pilcrow in the file. Then I paste the content into Notepad, and then copy it all back into the new file I have waiting.
Why do I leave out the last pilcrow?  The last pilcrow in a document has a lot of formatting information in it, and if anything is corrupt, it’s more likely to be there than anywhere else. You can’t delete the last pilcrow in a document.
Put another way, it doesn’t hurt and it might help—to prevent future problems.




Selecting Text Vertically in Word
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Mellissa Ruryk�
Here is a list that someone has carefully typed and numbered manually.
You can see that they were careful to try to align the numbers by adding the same number of spaces before and between the numbers and content.
If you had to remove this manual spacing, you would have to position your cursor at the front of every line and delete the content – hundreds of keystrokes to deal with these 30 lines.
I could run several find and replace functions and replace spaces 2, 3, and 4 spaces with nothing… but even that takes a lot of keystrokes.
I recorded a little screencast to show you how only a few keystrokes and selecting text vertically can fix this issue quickly.
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Selecting Text Vertically in Word

The last step 
requires that you 
hold down the 
Alt key before 
dragging up and 
to the left.

Mellissa Ruryk�
ANIMATION

So I selected the text, searched for a period followed by two spaces and replaced that with a tab.

Then I set a tab stop on the ruler to give myself some room to work

Next I click at the bottom of the list and drag the cursor to the margin and up 
I click delete and all that content disappears. Ten keystrokes or so, and it’s fixed.




Re-format Tables
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▪ This section of 
content had the 
formatting stripped 
from it. 

▪ Quick way to fix that

Insert > Table > 
Convert Text To Table…

Mellissa Ruryk�
Insert > Table > Convert Text To Table…




Converting Text to Table
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• Set the number 
of columns you 
want

• Specify where to 
split the text

• Click OK



Text to Table
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Appraisal Faceting specimens Petrified wood
Arrowhead Flint Polished
Artisanal Flintknapping Precious gem
Beading Fossil Precious stone
Beads Gem art Rare
Cabochon Gemstone Rock
Cabs Gemstone jewelry Rock art
Carver Gold Rockhounding
Carving Gold jewelry Rose cut
Cast Healing Rough rock
Casting Inlay Sandblasting
Collection Intarsia Semi-precious
Commission Jewelry Setting
Consignment Jewelry repair Silver
Copper Knapping Silver jewelry
Course Lapidary Silversmith
Crystal Local made Silversmithing
Custom Market Slabbing
Cut stone Metaphysical Smithing
Cutting Minerals State gemstone
Design Mining Stone
Drill Natural Stone drilling
Exhausted mine Old stock Wholesale
Faceted stone Petrified stone Wire wrapping

Results of using 
Convert Text to 
Table

Mellissa Ruryk�
Sometimes it’s easier to type out the content you want in paragraph form rather than putting it directly into a table.
Use tabs to separate text.



Text to Table
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Type the content separated by tabs and use 
this function to create a plain table you can 
then style. 

Mellissa Ruryk�
Sometimes it’s easier to type out the content you want in paragraph form rather than putting it directly into a table.
Use tabs to separate text.



Convert Tables to Text
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▪ Select content

Tables Layout menu > 
Convert to Text

▪ Pick a separator

▪ Click OK

Mellissa Ruryk�
You might have content in a table that you need to quickly get out of a table format and into a paragraph format. 
Note you can specify another separator. Semi-colons are a good separator when converting a list of email addresses that you need to paste into an email’s To: line. After you convert the table to text, you end up with a usable list of email addresses without having to position your cursor at every paragraph mark, pressing delete and typing a semi-colon. 
(BTW, there is an extra step required to get this output:  Find and Replace each semi-colon with a semi-colon followed by a space.) 
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Style Gallery vs. Style Pane
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The Style Gallery is a shortcut to a subset of styles.

▪ To see the larger list of styles, click the disclosure 
arrow at the bottom right of the Style Gallery

Style Gallery vs. Style Pane

Mellissa Ruryk�
There are times you might want to apply a style that doesn’t appear in the Style Gallery or Style Pane, depending on how things are set up in the document you’re working on. First, a quick overview of the Style pane versus the Style Gallery.



Style Gallery vs. Style Pane
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Style Pane Options

▪ Affects how styles are 
listed in the pane
– Personal preference is 

In Current document, 
sorted in Alpha order

▪ Add a New Style

▪ Open the Style 
Inspector

▪ Open the Manage 
Styles dialog

Mellissa Ruryk�
ANIMATION

This is Word we are talking about here, so these are 2 different ways to get to almost the same information. Word just loves to embed different ways to find things and offer more than one way to dress up the dog (that’s my version of “skin the cat”).
The Style pane lists styles according to how you want to see them. The default is Word’s “Recommended” styles. But, you can see all styles, or just those in use.
You can sort them in Recommended Order, or by type – my personal choice is alphabetical.

Also at the bottom of the Style Pane are 3 buttons to add a new style, open the style inspector, or open the manage styles dialog.



Style Pane – Style Inspector

▪ Shows quickly what 
formats have been applied 
to the selected text
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AT the bottom of the Style page you click the Style Inspector and that dialog box opens. Click Reveal Formatting at the bottom of that dialog box, and you can see everything there is to see about that piece of text and how it’s formatted.  Both those dialog boxes can be docked on your window screen if you’d like.



Style Pane – Manage Styles

Assigning a priority 
to a style moves it 
up the list when 
sorted “As 
recommended” but 
also in the Style 
Gallery
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Click the Manage styles button to open this dialog. The Recommend tab is where you can set a priority for a style, which affects where it appears on the Recommended list and in the Style Gallery.
I’ll be going into this in more detail in the Templates webinar planned for later this year.
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Style Pane – Apply Style

Apply a style 
by clicking the 
style in the 
Style Gallery 
or use the 
Apply Style 
dialog

Mellissa Ruryk�
Now you might know that there is a style you want to apply but it’s not showing up in the Style Gallery or the Style pane. There is a quick way to apply a style using the Apply Style dialog box, accessed from the Style Gallery.

You can use the Arrows in the Style Gallery to move up and down in the selected styles. There can be up to 30 style shortcuts.
If you don’t see the style you are looking for, you can expand the Style Gallery by clicking the expand arrow.

ANIMATION

Here is the Create New Style button again.
There is a button that will strip all the formatting from any selected text.
The 3rd button is the Apply Styles button – click it and you can type in the style name you are looking for.
Or you can use the drop down to search for the style.
Remember we got here via the Styles Gallery - this button can open the Styles pane (one more way to dress up the dog)




Applying Styles – Creating a Style Shortcut

▪ Modify Style

Open Styles pane or locate the style in the Style 
Gallery, right-click > Modify

▪ But first, notice:
– Style based on:
– Style for following paragraph
– New docs based on this template

▪ Click the Format button
– This is where you find the shortcut key
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Some things I will point out quickly here for advanced users, that I plan to cover in detail in the webinar on templates:
This dialog box opens when I right-click the drop down arrow that appears when I hover on Heading 2 in the Style pane and select Modify.
#1, note that this heading is based on Heading 1. That means if I make changes to Heading 1, most changes will flow through and affect Heading 2 as well. (And Heading 3 and 4, because those are based on Heading 2 and 3, respectively.)
#2, see that I have also set up a Style for the following paragraph. That means when I type some content, apply heading 2 and hit the Enter key, the next paragraph will automatically be styled as a body text paragraph. That doesn’t help much in this editing exercise, but when I am creating a document from scratch, it’s a huge time saver. 
#3, if you get the feeling you’ve made that change more than once…. It’s probably because you forgot to click this on. You will be prompted to save the changes in the template when you close this document (if you have that option turned on).
Finally, #4 – the reason we opened this dialog box – this is where you set up a shortcut.
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▪ Put your cursor in the Press new 
shortcut key field
– Writes over any previous assignment

▪ I picked something I hope I’ll 
remember: Ctrl-H should remind 
me of headings, 2=heading level 2

▪ Clicking Assign moves the 
shortcut to the Current keys: 
field

Adding a Short Cut Key Assignment 

Mellissa Ruryk�
With your cursor in the “Press new shortcut key” field, press the combination of keystrokes you want Word to remember as a shortcut for applying Heading 2.
In this case you can see that the keystrokes I chose are already assigned to another command. It’s not a command I use often, so I don’t mind replacing it with this shortcut. Note that I didn’t pick a totally random set of keystrokes… there’s a chance I’ll remember that Ctrl-H will remind me of Heading and the number 2 relates to which heading I want applied.
One more step: I have to click Assign, which changes the display to:




Saving Shortcut Keys

▪ You can use the drop-down to select the 
current document or Normal.dotx as a 
place to store this shortcut.

▪ If you feel you’ve made this change 
before, maybe more than once – it’s 
because you didn’t save it in the 
template you are currently using.

2/19/2021Created by Mellissa Ruryk for Instructional Design & Learning SIG/COP of STC 54

Mellissa Ruryk�
Now the shortcut is embedded in the template I’m using for the document. If I wanted to store it in Normal.dotx, I can change “Save changes in:” to show that template.
As I said before, I’ve set up shortcuts for the main styles I apply more than any others, headings 1-4 and Body text.
I always use Body text as my base style in any document I’m going to work with more than once, because of that cascading feature of styles I mentioned before. If anyone changes Normal, and all my styles are based on Normal, there goes all my careful work!
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Speaking the Language of Love Word

When you learn to read Word’s codes and formatting marks, 
you can make it behave.



Word’s Codes

Codes, AKA:

▪ “hidden” 
characters

▪ Non-printing 
characters

▪ Formatting 
marks

Pilcrow, AKA the:

▪ Backwards P
▪ Paragraph mark
▪ Hard return
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Different people use different language to talk about Word, so here’s a cheat sheet of different terms
I recommend you work with the Codes showing if you are troubleshooting. Definitely when editing, perhaps not when you are composing.
The characters shown here make up Word’s alphabet, so to speak. It how Word talks to you!



Speaking Word’s Language -1

▪ Each pilcrow controls the paragraph formatting of the paragraph 
before it.

▪ Each section break controls the section formatting of the section 
before it.

▪ When you delete a section break, you delete the section formatting 
of the section before the break. The section before the break adopts 
the section formatting of the section after the break.

▪ There is one exception, the last section of the document. The section 
formatting for the last section is stored in the last paragraph mark of 
the document. 

▪ You cannot delete the last pilcrow in a doc, but you can cut 
everything from a doc except the last pilcrow and paste into new doc.
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Things you need to know about Word’s pilcrows – they are the storehouse for information in your document.



Speaking Word’s Language -2

▪ All headers and footers are associated with sections.

▪ Headers and footers come in pairs.
– No header without a footer, and vice versa 
– Either one or both of a header/footer set may be blank

▪ Every section has at least one header/footer set. 
– Create a new section  new header/footer set

▪ Add section breaks from front to back of document
– Take advantage of the "Same as Previous" setting for header/footer sets
– Understand “Previous” = previous same type of header/footer (i.e., same 

as previous First page header, same as previous Odd Page footer, etc.)
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Headers and footers come in pairs
They apply to a section
Each section has at least one header and footer pair and they are always there even if they they don’t have content in them
When you engage the Same as Previous setting, be aware that previous does not = most recent.
It means same a previous header or footer of the same type.
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How Do We Fix This?

Troubleshooting is much easier now…



Fixit Section

▪ What the heck?

▪ Look at the pilcrows:
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Fixit Section

▪ What the heck?

▪ Don’t cross reference both title and page number:

– (Heading is less likely to change, so xref page number. If heading changes, 
use Find and Replace to correct)
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Fixit Section

▪ What the heck?

▪ Putting captions at 
the bottom means 
cross-references 
reposition such that 
the user has to scroll 
to see the entire 
image.
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Fixit Section

▪ What the heck?

▪ Putting captions at 
the top means cross-
references reposition 
such that the user 
can see the entire 
image without 
scrolling.
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Shameless Plug

https://www.sfu.ca/continuing-studies/programs-and-
courses/area-of-study/writing-communications/technical-
writing.html. 

2/19/2021Created by Mellissa Ruryk for Instructional Design & Learning SIG/COP of STC 64

If you are interested in practicing these tips and 
creating your own How-to-Use-Word Manual with these 
and other tips, take a course called TCOM240 from the 
Lifelong Learning faculty at Simon Fraser University 
(SFU). It’s a course that is part of SFU’s Technical 
Communication Certificate, a well-regarded program 
that teaches the 9 core competencies of technical 
communication in 10 focused courses, plus a final 
3-month practicum project.

https://www.sfu.ca/continuing-studies/programs-and-courses/area-of-study/writing-communications/technical-writing.html
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References and Resources
• Kevin Stratvert (used to be Kevin from Microsoft) runs a channel on YouTube with excellent videos on 

Word.  One for beginners is How to use Styles in Microsoft Word.
• Allen Wyatt runs a website called wordribbon.tips.net  providing tons of information and assistance. He 

also offers a free weekly email called Wordtips—sign up on his site.
• Shauna Kelly’s advice was always spot on, but she passed away in 2011 from ovarian cancer. Basic 

information on her site (shaunakelly.com) is clear and exceedingly easy to understand, but not maintained. 
Newer features in Word are not covered.

• I was surprised to see so much free content at https://www.dummies.com/software/microsoft-office/word/ 
—in addition to selling the For Dummies books onsite.

• Using wildcards in Find in Word: https://wordmvp.com/FAQs/General/UsingWildcards.htm
• Printing individual pages and page ranges in multi-sectional documents: https://support.microsoft.com/en-

us/help/826218/how-to-print-a-range-of-pages-in-a-multiple-section-document-in-word-2
• Using bookmarks and cross-references in Word: 

http://www.docs.is.ed.ac.uk/skills/documents/3617/3617.pdf
• http://wordtrainingandtips.blogspot.com/2010/04/review-of-formatting-marks-aka_08.html
• https://www.online-tech-tips.com/ms-office-tips/show-reveal-formatting-in-word/
• https://www.howtogeek.com/357623/microsoft-word-keyboard-shortcuts-that-make-your-life-easier/
• Information about the SFU Certificate program and every course is available on 

https://www.sfu.ca/continuing-studies/programs-and-courses/area-of-study/writing-
communications/technical-writing.html. 

https://www.howtogeek.com/357623/microsoft-word-keyboard-shortcuts-that-make-your-life-easier/
https://www.sfu.ca/continuing-studies/programs-and-courses/area-of-study/writing-communications/technical-writing.html


The End

Mellissa Ruryk
mruryk@hotmail.com
1.778.233.4544

If you have any questions, call or email me
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Well, I hope I cleared up at least as many mysteries as I might have caused in this presentation.
Feel free to email or call with issues – I love to crack my Word whip to make it behave.
CAVEAT: don’t expect in-depth answers on numbering or template questions, because I haven’t written those presentations yet. 
Stay tuned to the IDL SIG because those will be coming up later in 2021 and Spring 2022.
Thank you all for your kind attention and I hope to see you again soon. Now go and feel the love!
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